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!" Introduction 

“myView2” is a successor model of “myView”.  It has been extended colors 
for the map, and added more flexible zoom function.  However, this new 
model “myView2” has NOT compatibility to load the configuration file from 
the older system “myView”. 
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#" Operating environment 
The myView2 is a Python script, installing Python 2.6, or 2.7 is necessary to 
run this program. We recommend Enthought Canopy as the analysis 
environment to explore, develop, and visualize on.  
https://www.enthought.com/products/canopy/ 
After downloaded the Enthought Canopy, it came in a zip file. This zip file 
comes with a setup program, so you need to unzip the file.   
 
Confirm that your system needs the system requirements before starts as 
fallows;  
 wxPython is for GUI, and matplotlib is for drawing graphs. 
 
Operating system support  
l CentOS 6.5 (x86_64)+ Enthought Canopy 1.4.0   
l Windows 7 64bit + Enthought Canopy 1.5.1  
l MacOS X 10.9.2 + Enthought Canopy 1.6.1 
If you are on MacOS X, please update the wxPython at Package Manager on Canopy 

application. 
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$" Start-up 

You have all done with processing completed until gets here. Find a 
mVview2.py file, double click the file will setup the Canopy program.  
From the editor Canopy, go to the menu bar, Run > Run File will start-up 
myView2 file. 
 
From the command prompt as follows: 
For Linux, MacOS 

 
l -d / --debug:  debug ON  
l -l / --log:  create a log file 
l -m [12345] / --message-level=[12345]: 

A small number brings more details in a message. 
J -a:    

A parameter to use when the program has the ABEND 
(automatically used CallAfter).  

 
(e.g.)   

python myView2.py -l -m 1 C:¥TEMP¥myView2¥samples¥wp.mvd  
%" Basic usage 
4-1. Menu Bar - Basic usage 

When the application start running, click  to open up a data file. A graph 

sheet is set in an initial layout file “plot_default.txt”.  
*Initialization files and setting printers are set in “config.txt”.   

python myView2.py [option] [layout file] 
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Figure 1 Menus and Dialog Boxes 

 
In a main screen, a default layout shows that there are three groups of 
figures.   Each one of group can be divided into small panels for drawing 
graphs.  In this default screen, it shows that there 3 groups, 14 panels, and 
25 graphs (see Fig.1). 
These groups have a constant value with the horizontal axis, and they can 
be divided into a plurality of panels of n rows × m columns.  Groups, 
panels, and graphs are numbered in order they appear by define data.   
Numbers for the graphs are developed in the order defined, graphs are 
described as traces on this system.  These are useful for when you want to 
set the vertical axis, and specify whether you want to draw for the graph. 
 

  

Group1 Group 2 Group 3 
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J Input the shot number 
You can choose a shot number (Data ID) on the tool bar, and for reference 
number too. This is to determine whether to plot the data of any shot 
number. 

 
Figure 2 Shot Number 

J Drawing 
Reloading button / rotating two arrows  
This is a basic function that you need to press this button every after time 
when you enter the shot number. 

 

Figure 3 Drawing 
J Mode: ON-line  

 

Figure 4 Mode ON/OFF 
This is to change the operation for acquisition of the data location. Each 
time when you press this key, changes acquisition operation into a cache 
folder or into an analysis server to find a data. 
You might want to restore the updated data to the cache folder, you need to 
access to the analysis server by pressing its ON. The cache folder will be 
overwritten and erase the previously existing data, and save it automatically. 
However if you are not connecting to the LHD-LAN (the analysis server), 
OFF mode will be useful to run the program.  
Each operation is as follows;   
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ON Line to get a data in the analysis server, connecting to the network 
(the analysis server)  

OFF Line to get a data in the cache folder, not connecting the network. 
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J Cache folder 
You need to access to the analysis server by pressing it ON when you want 
to restore the latest data to a cache folder.  It will be overwritten and save it 
automatically. 
However if you are not connecting to the LHD-LAN (the analysis server), 
OFF mode will be useful to run the program.  

 
J Other Settings 

File＞Open Open up a layout file 
File＞Save  Save a layout file 
File＞Export Outputs a data in txt. 

A profile name@shot number-module name_Z axis variable name.txt 

(e.g.  cxs7_tor_map@129755-cxs7_tor_Ti.txt) 

File＞Print  Save the graph in PostScript format. 
File＞Quit  Quit a program 
 
Edit＞Copy  Copy a graph to the clipboard.

Setting!Group and Trace"  

Customize setting for Group, panel, and 
drawing data.  

Setting!Legend"  

Setting the legend objects of the graph. 

Setting!Folder Path Set the path 

  

Figure 6 Path setting 

Figure 5 Setting menu 
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J Batch Processing 
Tool > Batch 

Specify the shot number for drawing 
continuously. 

 
Data ID:  Shot number  
Create PDF: To make PDF 
Print:  To print 

 
Figure 7 Batch Process

 
 
J Real Time 

 

Figure 8 Realtime 

NOTE:   
Please do NOT use “lastshot” when you send 

to a printer. Choose an acceptable one if you 

want to use a printer when checked the box 

for “send to Virtual Printer”. 

 

Check the available printer from the following 

address;  

http://kaiseki-dev.lhd.nifs.ac.jp/rails/virtual_printer/virtual_printer/virtual_printer 

 
Tool > Notify  

To run the command of the file which named A Notify.txt of configuration 
files.  

Tool > Server  
Change to a client mode that the operating program will be switched. 

 
Tool > Realtime 

To get a data when its synchronized the experimental sequence, and 
draw a graph. 

Diagnostics: measuring equipment, devices, etc. 
Delay:  specify the number to be displayed later than the current shot. 
Duration: display duration time 
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Tool > Recorder 
Coordinates will be added to the  
Recorder dialog when you click. 
 

File > Save  save contents 
Edit > Clear delete contents 
   

Figure 9 Recording
 
Tool > Cache Clear Delete the cache folder 
Tool > Module Reload Reload 
Help > About  Version Information, How to use 
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4-2. Layout setting for groups- Basic usage 
From the menu bar, Setting > Group and Trace to customize your graph layout.  
A defined list for groups and panels will be appeared. So you can edit a title’s 
text, size of the group, color, and more. 

 
Figure 10 Setting group and trace 
 
Add / Edit: Add.> OK > Redraw:  To add a new group. 

 
If you want to copy a layout design from a one of them, 
Choose one that you want to copy from the list > Add > OK. > 
Redraw 
And then, arrange whatever you like.   
Press Redraw to confirm the review. 

 
Remove: Remove a group from the list 
Move Up: Move up a group on the list 
All: Select a whole list   
 
Redraw: Redraw the graph 
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 Please make sure to Redraw to see the result every time you 
edit or change (layout, changing values for axis, etc.)

Customize layout 
The edit dialog is to configure the display area which is specified a rectangle of 
the coordinate graph from the lower-left to the upper-right corner. 
The coordinate graph is a relative in the whole screen which has lower left (0.0 
and 0.0) to the upper right (1.0 and 1 position.0). Within the group area can be 
divided into a plurality of panels. 

 

 
 

 

Num Rows:  A number for rows 
Num Cols:   A number for columns 
Gap:      A space between the panels 
Title:     A title for a group / panels.  
X:     X axis values 
 
Label X: X axis label 
 
Log Scale X: Logarithmic scale 
 
X Link to: Link to the other group to represent 

the graph to be on the same X axis 
values when you set min and max 
of X value. 

 
Common Y: If you checked this box, value of the 
Y axis for all the panel of this group will represent 
into the same Y axis values. 

 

Change Font Typefaces, Weight, Style, Color and Sizes in title, Fig.11 will be 
appeared when you select More of the title.    

Figure 11 Add and edit 
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Figure 12 More for a title 

Text:  A title 
Family: font family   
Style:"  character of style 
Weight:"  thickness of the character 
Size:"  size of the character 
Color:"  color of the character 
Rotation:" to locate a title 
HAlign:"  display position for a title (the horizontal 
direction) 
VAlign:"  display position for a title (the vertical 
direction) 
 
Press OK > Redraw 

Change X axis label; this example shows how to change the style (font size, 
color, etc.) of X axis label.

 
Figure 13 Change X axis label 

 

After 13 
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The myView2 shows stacking multiple plots, vertically with the same X axis with 
different Y axis.   
When you set the same values for X min and X max, the drawing data will 
automatically set to match the graph. 
As you see this example below, it’s a stacked on separate graphs with the same 
X axis, but each panel has unique values for Y axes.  
 
Change X axis Tick Values; this example shows how to change the details (font 
typefaces, locations etc.) for the x-axis when you select X. 
When the X-min and X-max to the same value, the graph will automatically plot 
to match the data. 

 
Figure 14 Change X axis Tick Values 

 
After 14 

Trim First: First data point will be hidden 
Trim Last: Last data point will be hidden 
 
Press OK > Redraw 
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4-3. Y-axis setting for each panels- Basic usage  

 
Figure 15 Set Y-axis for each panels

If you did NOT set Y axis values when you customized the layout of the group 
(see fig. 10: common Y), the Y-axis of each 
panel must be set individually. 
 
Choose one of the group > choose a panel > 
Edit  
A sub-window for setting of Y-axis will appear 
as Fig.15. 
 
Or, you can just double click directly on the 
graph of the main window (Fig. 16). 
 

Figure 16 Double Click on the graph&
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The group is a multiple columns representing Y values each against a specific X 
value. When plotting each series, you can easily select the Y values as they are 
present in columns but the X value is constant for each column. When the X-
min and X-max to the same value, the graph will automatically plot to match the 
data. If you checked in the box for “Log Scale X”, it will be a logarithmic scale. 
 
You can specify the min value and the max value for the Y-axis.  When you set 
the same value for min and max of the Y-axis, the graph will automatically plot 
to match the data. 
 
 

 
Figure 17 Set up 
 
 
 

 
Show Grid Y: To set a square grid graph. 
 
Show Legend Y: 

To displays the legend of the graph. 
 
Common Y: To set constant Y-axis values to all 

panels of their group. 
 
xy:  Create a xy dimensional graph. 
 
xy-y2: Create a chart with two Y-axis and 

one shared X-axis. You can also set 
the min and the max values for 
added Y-axis. 

 
xy-z: Create a three-dimensional graph 
 

Log Scale Y2: To set the log scale graph for Y2. 
 
Y link to: Link to the other panel to represent the graph to be on the same 

Y-axis values. Choosing a panel can be selected even from the 
same group, and other groups. 
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4-4. Drawing style setting- Basic usage 
Tips for an easy way to create a drawn graph that you can also use “Add” to 
make a copy of a plot data, and set some details as you want.  Press OK to put 
a new drawing data on.

Figure 18 Customizing Individual plot data 



 

17 
 

 

Figure 19 Set up Trace 
In the sub-window for setup trace, you need to fill out the form from the top to 
the bottom with specific details how you want to display. 
 
Group / Panel:  A location to be displayed.  
 
Module:   A diagnostics module name 
 
Shot:  Specify the shot number 
  C: A current number from the main screen.  
  R: A Ref number from the main screen. 
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   Add:  A file that you want to plot a data. 
 
X:  An object for X-axis. 

Generally, T is for time and R is for distribution for drawing a graph. 
 
Y:  An object for Y axis. 
 
Z:  An object for Z axis 
 
Index: 
(See Fig 20) If the plot data has more items (time-slices, location information, 
etc.), choose one of the multiple selected list from the dropdown. 
For example, if you chose the Time (Time-slices), a dropdown list comes up so 
you can specify whether to plot the time variation of any position. 
If you chose the R (distribution), you can specify whether to plot the distribution 
of any time. 
 
Option: The items appears if there’re more information of the plot data. Choose 
one of the item that will be changed by selected items at Module. 
 
Symbol: A symbol style. 
 
Size:  Size for control symbol or a plot line thickness. 
Style:  Line Style 
Width:  Linewidth 
Color:  Plot color 
 
Offset:  Stacked lines by Y offsets graph. 

(See Fig 19) (Y-max - Y-min)=1, so please use less than 1  

 
Factor:  Multiple axes 
 
Type:    
XY:  A xy dimensional graph.   
X-Y2:  A chart with two Y-axis and one shared X-axis. 
XYZ: A Three-dimensional graph 
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Show:  To check for display 
 
Offset: Using this feature prevents the curves from overlapping and ensures 
that each curve can be wiewed clearly. 
Make sure that the number shoud be less than 1.0 because the limited number 
is the Y-max.  e.g. (Y-max – Y-min) = 1  
 

  

 

Figure 20 offsetting 
Remove: Remove a data 
Move Up: Move up a data on the list. 
Set Index:  This is only for a milited 

mesurement modules.  You can 

set this 
up If the 
module 
has 



 

20 
 

multiple measurement points. 
Start: Initial value set point 
Step: Step size 
 

 
Figure 21Set Index 

  
 
 
 
 
Set Symbol: To change the look of a line shape.  
 
Check in the box > change the categories > OK > Redraw 

   
Symbol: Data marks 
Size: Size of the symbol (data marks) 
Style: Line design 
Width: Line thickness 
Color: The symbols and a line 

 
Figure 22 Set Symbol 
 

  
 

 
All: Select all the items on the list. 

 
Or, select a one of the list from the trace, and press this “All” button."  
 
e.g.  You can indicate the data(s) that are based on the same module. 
This is useful to plot the time slice data if the module has more 
information in index. (See Fig 22) 
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Figure 23 “All” button to select the data based on the same module 

 

4-5. Set graph legends- Basic usage  
From the menu bar, Setting > Legend > add, edit, and remove > Redraw 

 
Figure 24 Set Graph Legends 

 
Static labels are labels that are not bound to the data which is “LHD” in 
red writhing on this screen.  In other words they are statically drawn on 
the axis and don’t interact with the data in the viewport.  You can set 
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the horizontal and/or the vertical static labels, and you have the option 
to define a custom label formatter for the labels. 
Active Labels are that changes depending on the data to be displayed.   

 

 
Figure 25 Add S Label

 

> Add S Label (for a static label)

 

Figure 26 Add a Label 

 
> Add A Label (for active labels) 
 
Position X:"  Place for a label 
Position Y:"  Place for a label 
 
Module:     Set a module 
 
Data ID:  

C:  Data ID for a main screen 
"  R:   RefNo for a main screen 
   Any:  Shot numbers 
 
Arg:    A title name (reserved words 

included)  
" " "
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'" About configuration file(config.txt) 
Initialization files and setting printers are set in “config.txt”.  
There are only a few basic constructs allowed in the initialization file.  
Blank lines are ignored.  Lines beginning with a “#” are comments, and will 
be ignored too. 

  
For example 

PlotDefault = plot_default.txt A layout file for initial start-up 
 
PrinterIP = 133.75.51.200" " " Specifies the PostScript-compatible"

network printer 
 
vPrintPath = vprint" " " " " " Specify the location of the path where"

you want to output the 
generated PostScript file. 

 
(" Configuration File (Directory environments) 

myView2.cnf is the configuration file for the directory. 
For example 

"cachefilename": "cache.txt",  
    "cachefoldername": "cache",  
    "commandfoldername": "bin",  
    "config_version": "1.0.0",  
    "datamodulefilename": "datamodules.txt",  
    "datamodulefoldername": "DataModules",  
    "exportfoldername": "user/export",  
    "labelmodulefilename": "labelmodules.txt",  
    "labelmodulefoldername": "LabelModules",  
    "notifyfoldername": ".",  
    "printfoldername": "user/print",  

        "tempfoldername": "temp" 
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)" Layout file 
In the layout file, setting the drawing size, the group, the graph, the trace, 
also other text display settings are available. 

Let’s see how they go on the file using a”plot_default.txt” as follows;  
(Each parameter is separated by TAB after the key) 
 

7-1. Canvas size setting- Layout file 

 

 
7-2. Shot number setting - Layout file 

 
 
7-3. Others - Layout file 

 
 

 
7-4. Group layout - Layout file 

 
 
1. groupid： A group number belongs to the graph. 
2. nrows： Numbers of rows that divisions in the vertical direction 
3. ncols： Numbers of columns that divisions of the horizontal direction. 
4. left： The left edge for the entire group.  
5. bottom： The lower end position for the entire group. 
6. width： The width to draw the entire group. 

For example:  canvassize   1024 780 

For example: dataid  101368   105999 

For example; 
facecolor #dddddd 
realtime_printer   lastshot 

realtime_delay 1 
realtime_duration 150 

For example: 
group   0  6 1 0.05 0.05 0.4 0.85 0 3 6 0 0 0 0 1 0 -1 

-1 
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7. height： The height to draw the entire group.  
8. gap：  

The space that specifies the gap between the panels to each 
other.  

 
*Position, width, height, spaces are specified at a rate of the 
canvas size 1. 
So you need to set a number in between 0 to 1. 
 

9. xmin： X-axis lowe limit 
10. xmax： X-axis upper limit. 
11. logx： X-axis logarithmic scale. 0 / NO, 1 / YES. 
12. comy： A common Y-axis、0 / NO, 1 / YES. 
13. ymin： Y-axis lowe limit 
14. ymax： Y-axis upper limit 
15. logy： Y-axis logarithmic scale 0 / NO, 1 / YES  
16. legy： Grid display designation, 0 / NO, 1 / YES 
17. linkx：  

X-axis synchronization.  To provides controls to link layers so 
that the child layer can resize and move with the parent layer.  
Synchronize by specifying the number of 1 to 7. 
Please put a “-“(dash) before the number If you do NOT want to 
link layers. 

18. linky#  

Y-axis synchronization.  To provides controls to link layers so 
that the child layer can resize and move with the parent layer.  
Synchronize by specifying the number of 1 to 7. 
Please put a “-“(dash) before the number If you do NOT want to 
link layers.  
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7-5 Label setting for a Group- Layout file 
 

 
 
1. groupid： group:  

A group number belongs to the graph. 
2. text： Location  

Specify a title(t), X-axis(x), Y-axis(y), or Y2-   axis(s). 
3. at： A string of the label for the label. 
4. family： A Font family 
5. style： A character of style.  
6. weight： The thickness of the character 
7. size： A text size 
8. color： A text color  

A hash mark “#” followed by three pairs of hexadecimal digits, 
specifying values for red, green and blue components in that 
order. Or letters after the hash mark would be fine too.  

For example,  
a color of bright red is #FF0000,  
white is #FFFFFF,  
black is #000000,  
also in letters are 
r / red, g / green, c / cyan,m / magenta,  
y / yellow, k / kuro, and w / wite. 

9. rotation： A place for a title 
10. ha： Display location of the title (horizontal direction)  
11. va： Display location of the title (vertical direction)  
  

For example;  
glabel 0 x time (sec)  sans-serif normal normal medium #000000 0 center top 
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7-6. Tick label setting for a Group- Layout file 

 
 
1. groupid： A group number belongs to the graph. 
2. text：  

Specify a location for a title (t),  X-axis(x), Y-axis(y), or 
Y2axis(s).  

3. family： A font family  
4. style： A font style 
5. weight： A thickness of the text 
6. size： A size of the text 
7. color： A color of the text 
8. rotation： A place for the title  
9. ha： To display position of the title (horizontal direction)  
10. va： To display position of the title (vertical direction)  
11. ft：   

Display the chart axis start value, 
0 / NO, 1 / YES 

12. lt：  Display the chart axis end value,  
0 / NO, 1 / YES. 

 
7-7. Coordinate axes setting for a Panel- Layout file 

 
1. groupid： A group number belongs to the graph. 
2. panelid： A panel number belongs to the graph.  
3. ymin： Y-axis lower limit to range. 
4. ymax： Y-axis upper limit to range. 
5. logy：  

Y-axis logarithmic specified. Specify to a logarithmic scale 

For example:  
gticklabel 0  x sans-serif normal normal small #000000 0 center top 0 

For example:  
panel 0 0 0 10 0 1 0 -2 2 0 1 0 -1 -1 
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specified by 0 / NO or 1 / YES. 
6. legy： Legend display designation specified by 0 / NO or 1 / YES.   
7. type： 0 (xy) 、1 (xy2)、 2 (xy-z)  
8. smin： Y2-axis lower limit to range.  
9. smax： Y2-axis upper limit to range.  
10. logs： X-axis logarithmic specified by 0 / NO or 1 / YES. 
11. legs： Legend display designation specified by 0 / NO or 1 / YES.  
12. grid： Grid display designation specified by 0 / NO or 1 / YES.  
13. linky：  

Y-axis synchronization.  To provides controls to link layers so 
that the child layer can resize and move with the parent layer.  
Synchronize by specifying the number of 1 to 7. 
Please put a “-“(dash) before the number If you do NOT want to 
link layers. 

 
7-8. Label setting for a Panel- Layout file 

 

 
1. groupid： A group number belongs to the graph. 
2. panelid： A panel number belongs to the graph. 
3. text：  

Specify a location for a title(t), a X-axis(x), Y-axis(y), or 
Y2axis(s). 

4. at： A string of the label for the label. 
5. family： A font family  
6. style： A font style 
7. weight： A thickness of the text 
8. size： A size of the text 
9. color： A color of the text 
10. rotation： A place of the title  
11. ha： Display location of the title (horizontal direction)  
12. va： Display location of the title (vertical direction)  

For example; 
plabel 0 0 y sans-serif normal normal medium #000000 90 center bottom 
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13. ft：   
To display the chart axis start value, 
0 / NO, 1 / YES 

14. lt：  To display the chart axis end value,  
0 / NO, 1 / YES. 
 

7-9. Tick label setting for a Panel- Layout file 

 
 
1. groupid： A group number belongs to the graph. 
2. panelid： A panel number belongs to the graph. 
3. text：  

Specify a location for a title(t), a X-axis(x), Y-axis(y), or 
Y2axis(s). 

4. family： A font family  
5. style： A font style 
6. weight： A thickness of the text 
7. size： A size of the text 
8. color： A color for the text 
9. rotation： A place of the title  
10. ha： Display location of the title (horizontal direction)  
11. va： Display location of the title (vertical direction) 
 
 
  

For example;  
pticklabel  0 0 y sans-serif normal normal small #000000 0 

right center 0 1 
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7-10. Trace setting- Layout file 

 

 
1. groupid： A group number belongs to the graph. 
2. panelid： A panel number belongs to the graph. 
3. name：  

A data name, specify a one of the data (diagname) which 
recorded in a “diagdict.txt” file. 

4. idc：  
A shot number, specify a number of the current shot number, or 
a reference shot number. 

5. vx： An object for X-axis 
6. vy： An object for Y-axis 
7. vz： An object for Z-axis 
8. idx：index：  

If the plot data has more items (time-slice, location 
information, etc.), choose whichever not specified in the X-
axis. 
For example: 
When you chose the Time (time-slice), you can specify the 
time variation of any position in the “idx”.  
When you chose the R (distribution), you can specify the 
distribution of any time. 

9. option：  
Specify an available option of which a chosen module has. 
For example; 
Within a “tsmap” module, you can set the number of the frames 
to average as “ntavg-10” for the time direction. 

10. type： A type of the graph (xy, xy2, or xyz) 
11. s：  A type of the symbol 
12. ss： A size of the symbol 
13. ls：  A type of the line 

For example; 
 trace   1  0  cxmap6_tor  C  reff  Ti      27_4.0575s  xy  o  4  -  

0  #FF0000  1  0   1 
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14. lw： Thickness of the line 
15. color： color 
16. factor, offset：  

To prevents the curves from overlapping and ensures that each 
curve can be viewed clearly. 

17. show： To display the plot data, 0 / NO, 1 / YES. 
 
＊Plot Symbols and Plot Lines Characters 
    character           description 
    ============================ 
    -             solid line style 
    --            dashed line style 
    -.            dash-dot line style 
    :             dotted line style 
    .             point marker 
    ,             pixel marker 
    o             circle marker 
    v             triangle_down marker 
    ^             triangle_up marker 
    <             triangle_left marker 
    >             triangle_right marker 
    1             tri_down marker 
    2             tri_up marker 
    3             tri_left marker 
    4             tri_right marker 
    s             square marker 
    p             pentagon marker 
    *             star marker 
    h             hexagon1 marker 
    H             hexagon2 marker 
    +             plus marker 
    x             x marker 
    D             diamond marker 
    d             thin_diamond marker 
    |             vline marker 
    _             hline marker 
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7-11. Active label setting- Layout file 

 
 
1. name： A module name 
2. idc： A shot number (current or reference), specify the integer value.  
3. posx： Display location of the X-axis 
4. posy： Display location of the Y-axis 
5. arg： 
6. family： A font family  
7. style： A font style 
8. weight： A thickness of the text 
9. size： A size of the text 
10. color： A color of the text 
11. rotation： A place of the title  
12. ha： Display location of the title (horizontal direction)  
13. va： Display location of the title (vertical direction) 
 
7-12. Static label setting- Layout file 

 
 
1. posx： Display location of X-axis 
2. posy： Display location of Y-axis 
3. text： A title 
4. family： A font family  
5. style： A font style 
6. weight： A thickness of the text 
7. size： A size of the text 
8. color： A color of the text 
9. rotation： A place of the title  

For example; 
alabel dataid C 0.12 0.97  sans-serif normal bold 32 #000000 

0 left center 
 

For example; 
slabel 0.05 0.97 LHD sans-serif italic bold 32 #FF0000 0 left 

center 
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10. ha： Display location of the title (horizontal direction)  
11. va： Display location of the title (vertical direction) 
 
 
*" Server functions 
l You will be able to draw the specified drawing data through your client 

program during the experiment if you set the server mode. 
If you don’t specify the shot number (a data-ID or a Ref.ID), a current data 
of a main screen will plot as a drawing data.  
 

l When the screen comes up blank, there is no data which you specified. 
 
For example; 
1) Tool > Server > check in the box 

From this setting, the operating system of myVie2 is changed to a client 
mode.  

2) There is a sample program named “myViewClient.py” in the folder. 
You can arrange this program whatever you like. 
There’re some examples as follows; 
 
a)  

 
Passing a command argument with “dataid” and a shot number which 
you want to view. 

 
Figure 27 dataid_servermode 

 C:¥TEMP¥myView2> python myViewClient.py dataid 101912 
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Figure 28 server mode screen 

b)  

 
To draw the specified data with “reload”. 

 
Figure 29 Reload for a server mode

C:¥TEMP¥myView2> python myViewClient.py reload 
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Figure 30 Reload on a Screen 

 
Command 
(case insensitive) 

Command Argument Description 

reload  Drawing 
dataid A Shot Number Update a Data ID 
refid A Shot Number Update a Ref. ID 

 *Current Supported Command Reference 
 
9. In conclusion 

There is no guarantee that everything you need will work perfectly with 
myView2.  So this user guide explains the ideal operation of the 
system merely.  You may need to the additional work such as making 
the program ready for execution on the module setting if you needed. 


